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Preparation of the DSP board and the development environment
e Connect the DSP card to the PC. Attention! Plug the power cord first, then the USB JTAG cable.
Stick to this order if you need to reset the DSP card.
e  Wait until the ,,USB monitor” LED lights up! It means that the card has successfully connected to
the computer.
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e Start the development environment on the PC: CrossCore Embedded Studio



e Choose a directory for your workspace where your projects will reside.
o Ifthe chosen directory doesn’t exist, then it will be created.
o All of your settings will be saved here, so feel free to change them.
o Don’t use special characters in the name and make sure your group is easily identifiable.

7 CrossCore Embedded Studio Launcher X

Select a directory as workspace

CrossCore Embedded Studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | D:husershstudent w Browse...

[]Use this as the default and do not ask again

} Recent Workspaces

e C(Close the welcome screen.

¥ student - CrossCore Em _ O b
File Edit Source Ref r Mavigate Search Project Run  Window Help
= 7 Welcome = g

CrossCore ANAOS

Embedded Studio”

AHEAD OF WHAT'S POSSIBLE™

New Releases Welcome!

Software Releases in November 2022 ~ Welcome to CrossCore Embedded Studio. Below you will find
numerous resources that will help you learn more about the tools

* ADILISTN™ EZ-AUDIO SYSTEM - Rel 1.0.0. and products that you have installed. You can always display this

Software Releases in October 2022 page again by selecting Welcome from the Help menu above.
* CrossCore® Embedded Studio - Rel 2.11.1.
* SHARC and Blackfin Linux Command-Line ‘i _‘_.- : . :
Tools - Rel 2.11.1. Working with Projects
agage 4[)_1_.
* CrossCore® Utilities - Rel 1.7.1. * Create a new project

* |mport an existing CCES project
* Import an existing VisualDSP++ project
* Browse installed examples

* SigmaStudio+ - Rel 2.0.0.
Software Releases in June 2022

* CrossCore® Utilities - Rel 1.7.0.
Software Releases in May 2022

s CrossCore® Embedded Studio - Rel 2.11.0. 5.; Viewing Documentation
* SHARC and Blackfin Linux Command-Line * Open the online help
Tanle _Rel 2110 v

* Download additional processor documentation

Getting Started

/ Getting Help
* Visit the DSP Community on EngineerZone
+ Contact Analog Devices Support

The Waorid Leaderin High Performance Signal Processing Saksions




e Download the sample project from the webpage of the laboratory course.
Unzip the file into your workspace. Take care to unzip it into a subfolder with the name of the
project! This is necessary because the IDE has a one project per folder policy.
e Connect the jack — BNC cables to the Line-in and Line-out connectors of the DSP card.
o Attention:
= Take care of the labels on the input and output connectors (Line-in/Line-out)! Do
not connect the Line out to the output of the signal generator!
= The maximum input on the line in channel is 3 V,. Make sure the output of the
function generator is less so the input won’t be overdriven! On Hameg generators
the -20 dB button should be pressed! (Hameg function generator: max. 20 V)
o Connect the ,Line out” output to the oscilloscope (both channels).
o Connect the ,Line in” input to the signal generator (the channel does not matter). Set a
sine wave output signal on the generator.

Opening a project
e Open the BlackFin_Frame project in the previously unzipped folder! To open a project: File >
Open Projects from File System..., and here the project folder has to be selected!

7 Impert Projects frem File System or Archive O x

Import Projects from File System or Archive ==\

=
This wizard analyzes the content of your folder or archive file to find projects and import them in the IDE.
Impert source: D:vusers\student\BlackFin_Frame V| I Directory... I Archive...
type filter text Select All
Folder Import as Deselect All
BlackFin_Frame Eclipse project

1 of 1 selected
[[]Hide already open projects
[] Close newly imported projects upon completion

Use installed project configurators to:
Search for nested projects

Detect and configure project natures

Working sets
[[]Add project to working sets New...
Select...
Show other specialized import wizards
lf?)' < Back Mext = Finish Cancel




e Now you can see the Process_data.c file in the project window under the BlackFin_Frame project
among other source files. The Process_data.c file contains the following signal processing method:
o void Process Data (void) runsifanew sample is available from the ADC.
o The iChannelORightIn and iChannelOLeftIn variables contain the sample of
the left and right channels.
iChannelORightOut and iChannelOLeftOut contain the data sent to the DAC.
The UART peripheral signals the availability of a new character through the
uart rx flag. It must be cleared to receive the next one! Use uart getch() to
readitand uart putch() oruart print () to write to the serial port.

7 student - CrossCore Embedded Studio — O %
File Edit Source Refactor Mavigate Search Project Run Window Help

o R RN ] E IS ] = |@Ees
|7 Project Explorer &2 = 8 5= Outline 2 = 0
= <§) - = 5
w == BlackFin_Frame An outline is not available.
[ Includes
w [ sre

conv_asrm.asm
[£ Initialize.c

[& ISR.c
LabFrameFIR.h

[ main.c

[£] Process_data.c /
[ sin2pi_fx.c

sindpi_fx.h

Talkthrough.h

[€] vart.c

uart.h
=| BlackFin_Frame Debug.launch

system.svc

e Compile the project! Compiling options:
o F7keyor
o Project menu > Build project or

o click on the % button.
e If you want to rebuild the project (and clean all previous files):
o Project menu - Clean...

#7 Clean O >

Clean discards all build results and states. The next time a build occurs the selected
projects will be rebuilt from scratch,

Clean all projects

IECEIackFin_FramE

Start a build immediately
(®) Build the entire workspace
(O Build only the selected projects




e Start a debug session and upload the project!
o Check that the DSP board is indeed connected!
o Forthefirst time you need to select a debug configuration: Run = Debug Configurations...
Then select Application with CrossCore Debugger = BlackFin_Frame Debug and click on
Debug!
F5 or
Run - Debug or

o click on the #*F button.

7 student - CrossCore Embedded Studio

- O x
File Edit Scurce Refactor Mavigate Search Project | Run Window Help
g | ® & -~ Bifni s~ Q ~i@ & Debug B o~ [Quick Access] | g% | [ER c/cer
17 Project Explorer &2 = 8 Debug History * = B ||E= outline 2 = B8
= <_E|> - - 5 Debughs . . >
Debug Configurations... An outline is not available.
[
# Binaries Breakpoint Types b
[ Includes
v [ sre @, External Tools >
[8] conv_asm.asm
27 Debug Configurations O *

Create, manage, and run configurations

Select a debug session to launch and a pregram to load

1, - —*l,
Ié) ~ = XK | H 5P Name: | BlackFin_Frame Debug
type filter text ﬁ Session . % Automatic Breakpoint @ Target Options 50;;%5 Custom Board Support
v b Application with CressCore >,

2

|l BlackFin_Frame Debug

I Application with CrossCore
& Application with GDB and O Target: Blackfin Emulators/EZ-KIT Lites

L Application with GDB and O Platform: ADSP-BF337 EZ-KIT Lite via Debug Agent
Processor: ADSP-BF537

Session configuration

Select Seszion...

The following program(s) will be loaded:
Program Options Silicon revision Add...
[] BlackFin_Frame\Del Reset, Check si-revision, Run after load 0.3 Edit...
Remove...
Remove All...
Mowve Up
Mowve Down
Restore Defaults...

< >
. . Revert Apply
Filkter matched 5 of 10 items

@I \ Close




e Run the project! (After uploading the program, it will be automatically halted at the first
instruction). You should be in the debug perspective for this. To run the program:
o F5or
o Run menu - Resume or

o click on the ™ button. (If this button is greyed out you need to click on the Debug
window next to the Project explorer tab.)
To stop the program:
o Shift+F5or
o Run menu - Suspend or

o click onthe Y button.
e The project simply forwards the signal of the right (left) input channel to the right (left) outputs.

£, student - BlackFin_Frame/src/main.c - CrossCore Embedded Studio -
7 stud BlackFin_Frame/src/mai CrossCore Embedded Studi O *
File Edit Source Refactor Mavigate Search Target Project Run  Window Help
it | @i b o> ®3 .0 it - Q-id Y- idiY - F ey
e | B cre--Gpoans
4% Debug | Project &2 = 8 || [g mainc 2 = 8 |[x=Vari ¥ - % Bre}%":ExpT = 8
= % = v 37 playback data are written intoc the wvariables - t = | [=<J> e O
< BlackFin F - 38 ChannelxLeftOut and ChannelxRightOut respective
vie Locrin-rrame 39 are then sent back to the DAC (AD1854) in the SI Mame Type Value
3%, Binaries 48
ﬂﬂlndudes 41
v 23 src 42 // left input data from AD1871
E]conv asrm.asm 43 wolatile int iChannel@LeftIn, iChannellleftIn;
R E'F 44 // right input data from AD1871
E]|2AMIZEC 45 wolatile int iChannel@RightIn, iChannellRightIn;
-C 45 // left guput data for AD1854
@ LabFrameFIR.h 47 wolatile int iChannel@lLeftOut, iChannellleftOut;
[£ main.c 48 // right puput data for AD1854
[& Process_data.c 49 wolatile int iChannel@RightOut, iChannellRightout;
N 5@ // SPORT@ DMA transmit buffer
g sinZpi_fi.c 51 int iTxBufferi[2];
[B] sin2pi_fx.h 52 // SPORT® DMA receive buffer
[n] Talkthrough.h 53 int iRxBufferi[2];
@ uart.c
[B] warth
& Debug main
|Z| BlackFin_Frame Debug.launch
system.sve After calling a few initalization routi
waits in a loop forever. The code to p
data can be placed in the function Proc
file "Process_Data.c”.

Init_Flags();
Audio_Reset();
Init_Sporte();

Init DMA();

Init UART();
Init_Interrupts();
Enable_DMA_Sport@();

[N R T S UYL I R I RS )

while(1);
}
7
7 W
£ >
& Console 52 l:__ Problems} Q Executables} S Eﬁ i_<| ~ 2 - ﬁ = O
Output

Loading application: "D:\users\student\BlackFin_Frame‘\Debug\BlackFin_Frame.dxe"
Load complete.




Debug functions of the IDE

For this part open the BlackFin_FIR_asm project. The program copies the right input to the left
output channel while the right channel outputs the filtered right input.

Reading and writing variables in the memory.

e Inorder to access the memory of the DSP you need to open the Memory Browser: Window menu
- Show view = Memory Browser

e To select variables to monitor click on =d . On the newly opened window search for the variable
to monitor.

e By right-clicking on a memory region and selecting , Select Format” you can choose the format of
the data representation. For example, choose ,Signed Fractional 16 bit” for fractional numbers.

e By double clicking on a variable its value can be modified. After entering the new value, confirm
it by hitting the Enter key. Then it will be updated in the memory of the DSP.

e These features can be used only if the DSP is in ,Halt” state, so the running program must be
halted first.

e To study some variables in the program, insert Breakpoints by double clicking next to the selected
line of the code on the grey bar on the left. When the program arrives to the selected line, its
state will change automatically from running to halted.

S s Ay Tt Signed Integer
7 Browse for Symbol O * b .
uffer Unsigned Integer
Select a symbol: Floating Point 32 bit
| in] Signed Fractional
., Unsigned Fractional
mools
Y Signed Integer 32 bit
Symbol Address Memory Space | |calling a few initi Signed Integer 16 bit
: in a loop forever.
_.enable_lnt Oxffal0a02 BLACKFIN Memc ;: EE ;igce; inethe Signed Integer & bit
_in_scratchpad Oxffalllbg BLACKFIN Memq Process Data.c”. Unsigned Inteqer 32 bit
_mi_initialize Oxffal13a8 BLACKFIN Mem¢ | |------- e _9 9 :
adi_osal_UninstallHandler Dxffalld70 BLACKFIN Mem fr=tpediiniegaglGhic
check_addresses_in_tables Oxffal02f6 BLACKFIN Mem¢ Unsigned Integer 8 bit
input (xff200000 BLACKFIN Mernt Signed Fractional 32 bit
main (cffalDabd BLACKFIMN Memi Signed Fractional 16 bit
no_page_in_table Onffal0dfd BLACKFIN Memq Sianed Fractional & hit
stack_and_heap_in_L1_data_a 0xFf800324 BLACKFIN Mem , | |Address ’ ianed Fractional 32 bit
ﬂSIgﬂE ractona I
< 2 = Ubsigned Fractional 16 bit
_ Unigned Fractional 8 bit
@' Cancel Column Hexd
< = Lopy foChipboard Hex16
& Console |[£] () b = | i - =
. Binary 32 bit =
OhcFFB0D00E Properties ) ) v|| Go| | New Tab
Binary 16 bit -
OxfFB00000 - Oncf Select Mumber of Columns... Binary & bit
Address \ Select Format > Character
FFE@aaae - 48 .
FF3@aaes +8. -a. -8.
FFroaaale -a. -a. -a.
FF3@a818 -8. -a. -8.
FF200020 -8. -8. -8.
FF3@a828 -8. -a. -8.
£ > |l rronnnan - - -




Plotting data arrays.

Select Window menu = Show view = Plot. This opens a new window.

Click on ® to open the plot configuration. Here you can add new datasets to the plot.

[ ]

e After clicking on the button New the Edit Data Set window opens. Here you can specify the name,
length and data type of the array you want to plot. Click the button Add after specifying these
parameters. The array can be selected with the Browse button. First select the input variable.

e Enter the length of the array to the Count field. For the input array this is 401.

e Stride defines the step size. Its value should be 1.

e Select the number format in the Data list. Choose short.

e The DSP must be in Halt state to use these features otherwise it will use the values saved during
the previous halt. Use breakpoint(s) or the Pause debug button to halt the processor.

e The sampling frequency of the ADC and DAC is 48 kHz. Adjust the frequency of the input signal
until the sampling is coherent (an integer number of periods is measured of the input sine) and
plot the result (e.g. measure 7 periods of the signal). Next measure a sine with noncoherent
sampling by changing the signal frequency. Plot the result and explain it (circularity of the buffer).

e Modify some elements of the input array and plot it again.

e Plot and study the filter coefficients (coefs variable), explain the filter characteristics (bandpass
filter = lowpass filter modulated by a sine wave).

7 Plot Configuration [m} h¢
General
Type: |Line plot ~ Settings...
:‘:'_ y Data sets
gg ....- ;;r;;;:;.c-:r;- @ Data Set 0 [Address="input’, Count=401] New...
gg :: Descriptil Edit...
7 Edit Data Set O X Delete...
Name: | Data Set 0 | Style..
V-Asis Process...
Address: | |npuﬂ | | I"/
Memory: | ELACKFIN Memory
Count: | 401 ‘ Stride: | 1 | Offset: | 0 |
Diata type: | Signed Fractional 16 bit ~
ot 11 e i tg v -0
© - Untitled
£ >




Runtime-analysis

Select Window menu - Show view > Profiling and open a new runtime statistics.

Launch the program and collect data by clicking on & . Analyze the the run-time of different

functions. Measure the run-time percentage of the conv_asm function. (Optionally visualize it

with a pie chart by clicking on one of the buttons.)

Modify the memory section of the input or the coefs variables (from section ("L1 data a")

to section ("Ll data b"), orviceversa). The variables should be in the same memory

section.

Measure the run-time percentages again. What is the difference? (To delete the previously

measured statistics manually click on % while the processor is halted.)

42 // left input data from AD1371

43 wolatile int iChannel@LeftIn, iChannellleftIn;

44 // right input data from AD1871

45 wolatile int iChannel@RightIn, iChannellRightIn;

46 // left guput data for AD1854

47 wolatile int iChannel@lLeftOut, iChannellleftOut;

48 // right puput data for AD1854

49 wolatile int iChannel@RightOut, iChannellRightout;

5@ // SPORT@ DMA transmit buffer

51 int iTxBufferi[2];

52 // SPORT@ DMA receive buffer

53 int iRxBufferi[2];

54

55

e I e e e R
57 // Function: main

58 //

53 // Description: After calling a few initialization rout
6@ // waits in a loop forever. The code to p
61 // data can be placed in the function Proc
62 // file "Process_Data.c”.

= void main(void)

1
Init_Flags();
Audic_Reset();
Init_Sporte();
a Init DMA();
a Init_Interrupts();
1 |  Enable_DMA_Sport@();
3 while(1);
4}
5
76 W
< >
& Conscle l:_ Problems O Executables Profiling £3 éé, b Y T I]- [ v| L=<j ¥ = B8
Execution Unit Percent I Samples
main() 8230 I 433668
Process_Data() 1642 87857
Sport0_RX_ISR() 1,21 | 6475

> ||Total Samples: 533000

Elapsed Time: 00:00:13
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FIR filter with assembly routine

Open the BlackFin_FIR_asm project! This is a FIR filter application: it filters the signal on the right
channel of the input. The filtered signal is forwarded to the left channel of the output. On the
right channel the original signal appears without being filtered.
Study and understand the code. Notes:

o The iChannelORightIn >> 8 and out <<8 commands are shifting the data

because the ADC and DAC are of 24 bits, but the DSP works with 16-bit data.

o The filtering is done in the conv_asm function.
Compile and run the project.
Measure the cutoff frequencies of the filter using the signal generator and the oscilloscope. What
type of filter is implemented? Compare the filter with the original one designed in Matlab: load
the coefficients withtheh = load(‘bp fract.dat’); command then create a figure of
the transfer function with fregz (h,1,2716,48000) ;.

Implementing FIR filter in C

e Open the BlackFin_FIR_fract project.

e Study the implementation of the circular buffer.

e Measure the run-time percentage of the signal processing procedure.

e Select Project menu = Properties. In the new window select C/C++ Build = Settings and then on
the Tool Settings tab select Crosscore Blackfin C/C++ Compiler = Language Settings. From the list
select Never (-no-circbuf).

e Compile the project again and launch run-time statistics. Study the results.

e Enable circular buffer generation option again in the options.

7 Properties for BlackFin_FIR_fract O e
type filter text Settings f=1n g r v
Resource
Builders 2
w C/C++ Build Configuration: |Debug [ Active] ~ | | Manage Configurations...
Build Variables
Environment
ngging & Tool Settings {8 Processor Settings Build Steps Build Artifact Binary Parsers @ Error Parsers
Warnings ~ 8y CrossCore Blackfin Assembler [1Disable Analog Devices extension keywords (-no-extra-keywords)
C/C++ General @ General [ Enumerated types are always int (-enum-is-int)
P'UJ:ECt Matures %: Prep.r.ocessor ) [] Do not treat floating-point operations as associative (-no-fp-associative)
Project Referenc.es (£ Additional Op.tIDHS i [ Treat saturating addition as associative (-sat-associative)
Run/Debug Settings ~ ) CrossCore Blackfin C/C++ Compiler i
@ General Structs/classes do not overlap (-structs-de-not-overlap)
- []C++ exceptions andR'I'I'I(-eh/—rttD,
Circular Buffer Generatiorh] Even when pointer may be outside buffer range (—fo@
@ Run-ime Checks n Ch.eck initialization order.(-check-init-order] .
@ Profile-guided Optimization [1Pointers to const may point to non-const data (-const-read-write)
(# Warning [ Literal strings are const (-const-strings)
@ Processor ] Allow multi-line character strings (-multiling)
@ Additional Options [] Compile C++ source files with C++11 feature extensions (-c++11)
v & CrossCore Blackfin Linker [ Use the Full C++ Standard Library and idged library (-full-cppli v
= ++ ry and not the abridged library (-full-cpplib)
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Appendix

Using the built in fractional type

The compiler has a built in fract type, which is a native type like int or char. It is provided by the
compiler (as per Extensions to support embedded processors 1ISO/IEC Technical Report 18037). It
has variants like int, so the following are valid examples: short fract, unsigned fract, etc. Signed
types are in the [-1,1) range while unsigned types are in the [0, 1) range. The table below
summarizes the fixpoint representations.

To access the fract type one needs to include stdfix.h!

Be aware that fractional calculations always saturate! This might cause problems in certain cases
so the accum type can be used to avoid those. It uses more integer bits, the representable
numbers are in the [-256, 256) range.

For fract constants use the r suffix (i.e. 0. 75r), for accum constant use k (i.e. 3.25k).

There are functions to convert between 16 bit integers and fractional numbers. They are listed
in stdfix.h and in the documentation of the compiler (CrossCore Embedded Studio = Blackfin
Development Tools Documentation = C/C++ Compiler and Library Manual = Compiler = Using

Native Fixed Point Types = Bit-Pattern Conversion Functions):
o bitsr (f) :fract > short
o rbits (s) :short - fract

e Type casting is the recommended method of conversion between fract and float values.

Type Representation Range sizecf Returns
ahort fract s1.15 [-1.0,1.0) 2
fract 51.15 [-1.0,1.0) 2
long fract 51.31 [-1.0,1.0) 4
unsigned short fract|p,16 [0.0,1.0) 2
unzigned fract 0.16 [0.0,1.0) 2
unsigned long fract |0.32 [1],1],1.1]] 4
short accum 50.21 [-256.0,256.0) g
accum 59,31 [-256.0,256.0) 8
long accum 50.21 [-256.0,256.0) g
unsigned short accum|g.32 [1],1],256.0} a8
unsigned accum g8.32 [0.0,256.0) 8
unsigned long accum | §.32 [0.0,256.0) g
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Common bugs of the IDE
e After loading the program to the development board the debug toolbars’ icons are greyed out
so the program cannot be started.
o Switch to Debug perspective.
o On the left bring the Debug tab into foreground (instead of the Project Explorer).
e Failed to resolve « MACRO » error. The project can be compiled but the problem tab shows an
error.
o Rebuild the index by clicking on Project menu = C/C++ Index = Rebuild.

e When launching a new debug session there is an error with the text “Error in launch sequence.

Failed to connect to processor. Failed passing SOM test.” This is caused by a previously failed
launch attempt where the development board wasn’t connected or powered on.
o Restart the IDE.
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